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1. Introduction

1.1 Overview

The AdapTag Development kit provides a working reference design for software
development of sub 1GHz RF applications based on the TI CC430 MCU and the 1.44",
2" and 2.7” EPDs from Pervasive Displays. The AdapTag development kit consists of
one AdapTag host connected to an EZ430 USB dongle and three AdapTag slave
boards each connected to an EPD.

The purpose of this document is to give an overview of the AdapTag Development Kkit.
This document also serves as an introduction to Pervasive Displays Inc. (PDI) EPD
driving technology to explain the program code of COG driver to operate the EPD for
TI CC430 MCU based solution. It applies to PDi's 1.44", 2", and 2.7"” EPDs. All of the
source codes are licensed under the Apache License, Version 2.0 (the "License"). You
may not use the code except in compliance with the License.

For more introductions on the COG driver, please refer to PDi’s “E-paper Display COG

Driver Interface Timing” which document number is 4P008-00 [9].

1.2 Kit Contents

Name

Photograph

Note

AdapTag Host board

1 piece.

marked with blue label
“HOST”

AdapTag Slave board

3 pieces.

marked with white labels
with 4 digits number
(Slave ID) “1401",
“2001” and “2701”

eZ430 USB Dongle 1 piece.
CR2450 Coin Cell 3 pieces.
Battery
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1.44", 2" and 2.7" EPD : 3 pieces.
R e 1 piece of each panel size
AdapTag
Development Kit
i3 TEXAS
INSTRUMENTS
AdapTag
Development Kit
1‘ N &
| AdapTag
Development Kit
AdapTag Manager Install AdapTag Manager software
installer working with AdapTag kit
1.3 System Diagram
AdapTag AdapTag Host AdapTag Slave
Manager
A
( \
USB Dongle AdapTag Slave EPD
Board Board
COG driving

(this document)

1.4 The Project Code of AdapTag

1.4.1 Development Tools

[1] AdapTag Manager:
Developed by Microsoft® Visual Studio® 2010
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AdapTag Manager is the GUI working with AdapTag Development Kit. It is also
defined System Packet and functions that communicates with AdapTag Host.

[2] AdapTag Host & Slave:
Developed by Texas Instruments® Code Composer Studio™ (CCStudio) 5.0
The firmware codes are programmed in AdapTag Host and Slave board. They are
also defined the Protocol Packet and functions that communicates between
AdapTag Host and Slave.

1.4.2 Folder Structure

Switch to the project folder in CCStudio. You will find the directory structure as below:

Folder Description

AdapTag Host The project folder of Host

AdapTag Slave The project folder of Slave

Common Most of the project files are located here.

(The project has defined “Predefined Symbols” to
differentiate between host and slave in the codes.)

— ALPS Library ALPS functions, parameters and structures

— DataHandle CC430 UART driver and interface

— ePaper COG driving waveform, process and driver

— General Central control process and general functions

— Memory Memory control, allocation and flash/ram driver
Library The ALPS compiled libraries: AdapTagHostLibrary.lib

and AdapTagSlavelibrary.lib

1.4.3 File Explanation

In the “ePaper” folder, the COG driving codes are divided into three different functions
which are driver, process and controller.

» Display_Controller.c:
The main point to start process for initialing I/0O, driving COG and storing image
to memory. It provides overall steps matching the COG driving flow from power
on, initialize driver, display image and power off. Developer is able to call the main
function (e.q. epaper disp (EPD Type, Previous Image, New Image) for a
completed display cycle.

* Display_COG_Process.c:

This file consists of the functions for updating the EPD. Each function implements
the step for COG driving flow. It also provides most of the EPD parameters to
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separate difference sizes allowing developers easier to adjust initial parameter,
resolution, frame time and so on.

* Display_Hardware_Driver.c:
This file includes the configuration and initialization of PWM, SPI and other I/0Os.

The SPI command and format are also defined here. The .h file defines
meaningful I/O variables.
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2. Preparing Image Data

The image pattern to COG supports 1 bit Bitmap (BMP) image format (Black/White) only.

This section introduces how to structure and prepare the image data for COG to load on
EPD.

2.1 Preparing Image Packets

A BMP image file consists of either 3 or 4 parts as shown in the diagram below. The
first part is a "Bitmap File Header”; this is followed by a “"Bitmap Information Header".
If the image is indexed color then the “Palette” follows, and last of all is the “Image
Data”. The position of the image data with respect to the start of the file is contained
in the header. Information such as the image width and height, the type of
compression, the number of colors is contained in the information header.

Bitmap File Header

Bitmap Information Header

Optional Palette

Image Data

The following image data will use this 2 inch 1 bit bitmap image file as example.

CHIMEI
LCD Display X series 55"
TL-55X73000

AN A

2.2 Bitmap Header

< File header: 14 bytes

This block of bytes is at the start of the file and is used to identify the file. A
typical application reads this block first to ensure that the file is actually a BMP
file and that it is not damaged. The first two bytes of the BMP file format are the
character 'B' (0x42) then the character 'M' (0x4D) in 1-byte ASCII encoding.

b1 ¢ 3 4 5 6 § § 9 @ b ¢ d g

00000000k 42 4D BE OA 00 00 OO0 OO OO0 OO0 3E 00 OO 00 28 00
00000010R: 00 OO0 C&8 00 00 00 &0 OO0 OO0 OO0 01 00 01 00 00 00
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Size

Offset (bytes) Purpose Example

0000h 2 Signature 0x42="B’, 0x4D="M’

0002h 4 File size OxABE=2,750 bytes

0006h 2 Reserved

0008h 2 Reserved

000Ah 4 File offset to | OXxX3E=62 bytes, starting address, of

pixel array the byte where the bitmap image data

(pixel array) can be found.
If the image is one bit bitmap file, the
starting address is always from Ox3E.

< Information Header: 40 bytes

This block of bytes tells the application detailed information about the image,
which will be used to display the image on the screen. The image info data that
follows is 40 bytes in length. It is described in the structure given below. The
fields of most interest below are the image width and height, the number of
bits per pixel (should be 1, 4, 8 or 24), the humber of planes (assumed to be 1
here), and the compression type (assumed to be 0 here).

o1 F 3 4 5 & 7 8§ 3 oo b g d g £
00000000R: 42 4D BE OA OO0 00O 00 00 00 OO0 3E OO0 OO0 00 28 0O
00000010R: Q0 Q0O C& 00 00 00 60 OO0 Q0O QOO0 01 0O O1 0O Q0 00
00000020R: OO0 QOO 80 O&4 OO0 OO OO OO QO OO QOO0 00 OO0 00 OO0 00
00000030R: 00 OO0 OO0 OO OO 00 00 00 00 OO0 FF FF FF 00 FF FF
00000040n: FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000050n: FF FF FF FF FF FF FF Q0 00 00 FF FF FF FF FF FF
00000060R: FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Size

Offset (bytes) Purpose Example
000Eh 4 Size of header 0x28=40 bytes
0012h 4 Bitmap width in pixels 0xC8=200 bytes=200 pixels
0016h 4 Bitmap height in pixels 0x60=96 bytes=96 pixels
001Ah 2 Number of color planes | 0x01=1
001Ch 2 Number of bits per pixel, | 0x01=1

which is the color depth

of the image
001Eh 4 Compression method 0, means no compression
0022h 4 Image size, the size of 0x0A80=2,688 bytes

the image data
For more information of the others, please refer to further introduction of
Bitmap file.
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2.3 Image Data

The image data that EPD needs is to remove the file header and information header.

0 1 ¢ ¢ ¢ 9 & 7 § 9 a2 b o d 2 §

00000000h: 42 4D BE OA 00 00 OO0 00 00 00 00 00 28 00
00000010R: 00 OO0 CE& OO0 OO 00 &0 OO0 OO0 0O 00 00
00000020R: 00 OO0 20 OA QOO OO0 OO 00 OO OO OO 00 00

00000030n: 00 OO0 OO0 QO QOO0 00 00 00 00 00 FF FF
00000040n:| FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000050h:| FF FF FF FF FF FF FF 00 00 00 FF FF FF FF FF FF
00000060h:| FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000070h:| FF FF FF 00 00 00 FF FF FF CB 7% 1D 72 2C BC &8D
00000080n:| 91 B1 D2 88 4F &% 33 42 2% DC 2E 9C 53 FF FF 00

> Image Data

00000a80h:|FF FF FF 00 00 00 FF FF FF FF FF FF FF FF FF FF
00000a%0h:|FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 00
00000aaldh:| 00 00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000ak0h:| FF FF FF FF FF FF FF FF FF FF FF 00 00 00

!

File size: OXABE
Image size =0xA80 = OxABE-0x03E

The bits representing the bitmap pixels are packed in rows. The size of each row is
rounded up to a multiple of 4 bytes (a 32-bit DWORD) by padding. The pixel number
of 2 inch EPD is 200 by 96. 200 divided by 8 bit equals 25 bytes which means one Line
on EPD needs 25 bytes image data. Padding bytes (not necessarily 0) will be
appended to the end of the rows in order to bring up the length of the rows to a
multiple of four bytes for 1 bit bitmap image file. The size of each row must be a
multiple of 4 bytes, so you can find a row uses 28 bytes (see below figure).

01 ¢ 3 4 % & 7 8 9 3 b cd e f
00000000h: 42 4D BE OR 00 00 00 00 OC 00 3E 00 OO0 00 28 00

=
00000010R: OO0 00 C8 00 00 00 &0 00 00 00 01 00 01 00 00 00
00000020R: 00 00 80 OR OO0 00 OO0 00 OO0 OO €00 00 OO0 00 00 00
00000030h: 00 00 00 00 00 00 00 00 00 00 FF FF FF 00[ FF FF
00000040h:| FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000050h:| FE_FF _FF FF FF FF FF 00 00 00|FF FF FF FF FF FF
000000&0R:| FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000070R: | FF FF FF 00 00 00/ FF FF FF CB 79 1D 72 2C 8C &D

The last three bytes are padding bytes which can be ignored.

The pixel of number of 1.44 inch EPD is 128 by 96. 128 divided by 8 equals 16 which
is already a multiple of 4 bytes. There is no padding byte in row.

The pixel of number of 2.7 inch EPD is 264 by 176. 264 divided by 8 equals 33. There
are 3 padding bytes.
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2.4 Code Explanation

In “AdapTag_API.cs” file of [1], the ConvertImageTolbit function supports
converting source image file to 1 bit BMP file format by assigned EPD size.

public static Bitmap ConvertImageTolbit (string ImageFilePath, string saveFilePath,
enumPanelSize Size)

For how to get the image data that just introduced above, the GensendBytes function
provides the approach to generate the image data that COG needs. The bitmap image
file (the BMPfile below) can be converted by “ConvertimageTolbit” function in
advance.

private byte[] GenSendBytes (string BMPfile)

{

FileSha

//The file path of BMPfile must been one bit bitmap image format already
int Real H Res = 0, Real V Res = 0;
byte[] content; //the byte array to store image data
byte[] tmp;
const byte BM Header = 0x3e;//0x3e is the starting address of image data
int BytesPerLine = 0;
List<byte> res = new List<byte>(); //res List to store image data without padding bytes
try
{

//Get the resolution from this bitmap

Bitmap b = new Bitmap (ReadImage (BMPfile)) ;

Real H Res = b.Width;

Real V Res = b.Height;

b.Dispose () ;

//Import the bitmap file to byte array
FileStream fs = new FileStream (BMPfile, FileMode.Open, FileAccess.Read,
re.ReadWrite, 80406);

fs.Seek ((long)BM Header, SeekOrigin.Begin);
content = new byte[fs.Length - BM Header]; //the size of content array is the file size

minus header size

multipl

exp.Mes

}

fs.Read(content, 0, content.Length);

fs.Close () ;

BytesPerLine = Real H Res / 8; //200x96; 200/8=25 bytes per line

int LineNumMod = (4 - BytesPerLine % 4) % 4; // The size of each line must be a
e of 4 bytes

int nIndex = 0;

for (int 1 = 0; 1 < Real V Res; i++)

{ for (int j = 0; j < BytesPerLine; j++)
{ res.Add (content [nIndex]) ;
nIndex++;
iIndex += LineNumMod; //Ignore padding bytes
imp = new byte[Real V Res * BytesPerLine]; //Image data List

for (int j = 0; j < res.Count; Jj++)
{
tmp[j] = (byte)res[j]; //List convert to byte array
}
}
catch (Exception exp) {if (OnErrorHandler != null)OnErrorHandler ("GenSendBytes :" +
sage); }

return tmp;
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2.5 Insert Image Header

When sending image data packets to host from AdapTag Manager, the image packet
will insert 8 bytes image header at the beginning of Image Data included Slave ID and
panel size information in order to have the target slave updating on correct EPD
content. The 8 bytes of image header are:

Byte O, 1 Byte 2 Byte 3 Byte 4, 5 Byte 6, 7

Slave ID State Panel Type | Horizontal Vertical

The value of byte 2 “State” is OxFF. It means new image. When the image is updated
onto EPD display, this byte in the flash memory will be changed to 0xAA. For more
information on the memory allocation, please refer to section 2.6.

Optional Palette

Image Header

Image Data |:> Image Data

Bitmap file structure

The image header structure is defined at AdapTag_API.cs file in [1].

public struct structImagelnfo

{
public UIntl6 SlavelID;
public byte State;
public byte PanelType;
public UIntl6 HORIZONTAL;
public UIntl6 VERTICAL;

}

The source code of inserting image header is at the end of "SendData” function
in AdapTag_API.cs file.

void SendData (UIntl6 Address, byte cmd, bytel[] payload, bool Start)
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2.6 The Memory Allocation

This section describes how this kit to store image data in memory. The CC430F5137
MCU has built-in 4K bytes SRAM and 32K bytes flash memory. The image data size of
1.44" EPD is 128 * 96 = 1,536 bytes and 2” EPD is 200 * 96 = 2,400 bytes. Both of
1.44" and 2” EPD are able to use internal 4K bytes SRAM to store new image data
from radio. However, the data size of 2.7" is 264 * 176 = 5,808 bytes causes the
built-in SRAM is unable to store a 2.7” image data, so 2.7"” will use flash to store new

image data.

2.6.1 The Memory Map in SRAM and Flash

< SRAM

0x1CO00

0x2591
0x2592

Ox2BFE

< Flash

0x8000

Ox97FF
0x9800

OxAFFF
0xB000O

OxB1FF
0xB200

OxFF7F

SRAM (Total 4K bytes)
0x1C00~0x2BFF

Image Area
Length=0x0992

Program use
Length=0x066C

Flash (Total 32K bytes)
0x8000~0xFF7F

Image Area 0
Length=0x1800

Image Area 1
Length=0x1800

Address Area
Length=0x0200

Firmware Code
Length=0x4D80

1.44" and 2" EPD need
maximum 2,400 bytes
memory space to store
image data in SRAM.

Divide 2,450 bytes = 0x992
space as image area.

2.7" needs maximum 5,808
bytes memory space to store
image data in flash.

Divide 6,144 bytes = 0x1800
space as image area.

One image area stores new
image and the other stores
previous (old) image. The
space is capable to store
previous image after 1.44" or
2" EPD was updated.
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2.6.2 The Steps of Storing Image Data

< 1.44" or 2”

AdapTag Host AdapTag Slave

SRAM | SRAM !
0x1C00 | 0x1C00
1) > (2) > !Update EPD
0x2208(1.44") ' 0x2208(1.44") |
*0x2568(2") 0x2568(2")
0x2BFE 0X2BFE
| (3) |
Flash
: 0x8000
0x8608(1.44")
! 0x8968(2")
E OXFF7F |
Note:

For 2” example: (200*96)/8 bit=0x960 bytes. 0x1C00 + 0x960 + 8 = 0x2568
The 8 bytes is added image header bytes.

The “State” byte in image header is oxFF (ImageState EMPTY in MemoryMap.h
of [2]) before updating on EPD display. After updating EPD, the image data
needs to store in the flash memory for comparing with new image for
compensate. The “State” byte will be changed to OXAA (ImageState Actionin
MemoryMap.h of [2]) which means it is old image.
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< 2.77

AdapTag Host

AdapTag Slave

0x8000

0x863F

0x8C7F

0x92BF

Ox96AF

Flash Flash

0x8000

BankO (1) (2) BankO

0x863F

Bank1 (3) 0x1CO00 (4) Bank1

SRAM 9)

Buffer 0x8C7F Update EPD

0x223F

Bank2 (5) (6) Bank2

0x92BF

Bank3 (7) (8) Bank3

0x96AF

The image data also has added the 8 bytes image header. The “State” byte in
image header is oxFF (ImageState EMPTY) before updating on EPD display. A
2.7" image data will be divided into four parts (bank0~3) for transmission. At
the slave side, it uses SRAM memory as buffer to quick store image and then
saves to flash memory. The new image data will be stored in either image area
0 or image area 1 depends on which area was cleared.

For PDi's COG driving process [9], the update stage needs to compare with
previous (old) image. The slave will determine where the “State” byte in image
area 0 or area 1 is OXAA (ImageState Action) and run the COG updating
stages and then proceed to update EPD display. After updating image on EPD
display, the slave will clear the previous image area in order to have the new
image to store here later. The slave will also change the “State” byte in current
image area to OxAA from OxFF.

For the steps above, find the sample code Save Image() in
Display_Controller.c [2]. The function of changing "“State” byte is
GetUseImageInfo in ALPS_USE.c [2].
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3. COG Timing Interface

This section provides an immediate implementation driving approach. It follows PDi’s
COG driving flow in the waveform document [9] and also gives sample source code to
get Temperature and Voltage value of CC430.

The COG driving code in [2] is able to drive three different EPD sizes (1.44", 2" and
2.7") according to the EPDType enumeration. It has been divided into three files
implements different function.

3.1 File Explanation

The three files below are in ePaper directory of [2].

<~ Display Hardware Driver:

Most of the initialization and configuration are put at here. User can implement
the driver layer of EPD if some variables need to adjust. The provided settings and
functions are SPI configuration and initialization, I/O control, PWM configuration
and EPD hardware initialization.

Display COG Process:

This file presents the waveform driving processes and updating stages. It is about
the COG driving waveform mostly. The parameters of driving different EPD is
defined at coc parameters t structure in Display_COG_Process.h file which is
easy for developer adjusting initial parameters, resolution, frame time of MCU
and the size of data line.

Display Controller:

The interface of Display Unit for external function wants to update EPD.
epaper disp (EPDType, PreviousImage, NewImage) is the main function for
COG driving process.

3.2 Code Explanation & Driving Flowchart

Please request the COG Timing Interface document [9] from PDi for more details to
compare the following functions and flowchart. The left flowchart below provides an
overview of the actions necessary to update the EPD in the COG Driver Timing
Interface document [9]. The right flowchart represents an overview of function flow
to match with COG driving flow in [2].
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COG Driving Flow Driving Flow in Code
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| |
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Write image data | ‘
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to the memory
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COG Driver Power_On () l
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0
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3
Initialize 1 .
COG Driver Initialize Driver () ?
g
N
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g.
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Write Image data from H
the memory to the EPD \ E
)
; Display (NewImage, -
No PN PreviousImage) %:
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" Update g
Complete? 3
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COG Driver oSl
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3.2.1 COG_Parameters Structure

This structure is to define the size difference of 1.44", 2” and 2.7".

ChannelSelect[8]; The different SPI Channel Select at “Initialize COG Driver” stage

VoltageLevel; The different SPI Gate and Source Voltage Level at “Initialize
COG Driver” stage

HORIZONTAL; The number of dots in a line. Image width.

VERTICAL; The number of lines of image. Image height.

DatalLineSize; Even + Scan + Odd bytes

FrameTime; Frame time of the COG

StageTime; Stage Time of the COG

3.2.2 ePaper Driving Process

(Find the code below in Display_Controller.c [2])

void epaper disp (uint8 t EPDType, unsigned char *PreviousImage,unsigned char *NewImage )
{

LED Red OFF(); //Turn off the LEDs

LED Green OFF();

ChangeFreq (EPDType) ; //Set the frequency by EPD type
Hardware Init(); //Initial display hardware

Power On ();

Initialize Driver (EPDType);

Display ((NewImage+Image INFO), (PreviousImage+Image INFO) );
Power Off ();

if (NewImage != PreviousImage)
{
Save Image (EPDType,PreviousImage,NewlImage) ;

}

ChangeFreq (EPD 144); //Set the frequency to 1.44” for saving energy

3.2.3 Write to the Memory

See Section 2 in [9].

Please refer to section 2.1 to 0 in this document how to preparing image data and
write to memory.
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3.2.4 Initialize Hardware
See Section 3.1 in [9].
According to the “3.Power On COG Driver” stage [9], some initial state as follows:
VCC/VDD, /RESET, /CS, /Border, SI, SCLK = 0. The Hardware Init () represents the
initial states above.
Display_Controller.c Display_COG_Process.c Display_hardware_Driver.c
epaper disp () Hardware Init() Init DisplayHardware ()
+ COG driving flow - Set time slot clock + SPI initialization
- Call driver layer + VCC/VDD, /RESET, /CS,
Init DisplayHardware () /Border, SI, SCLK =0
« Temperature initialization
+ See the sample code below
void Init DisplayHardware (void)
{
BITSET (PWM PORT DIR, PWM);
BITSET (CS_PORT DIR, CS);
BITSET (RST_PORT DIR, RST);
BITSET (DISCHARGE_DIR, DISCHARGE) ;
BITSET (PANELON PORT DIR, PANELON) ;
BITCLR (DRIVERBSY_PORT_DIR, DRIVERBSY) ;
BITSET (BORDER PORT DIR, PANELON) ;
panelon off () ;
spi init ();
spi _detach ();
init epaper pwm ();
cs low();
pwm_low () ;
rst_low();
discharge low();
border low () ;
TemperatureInit () ;
}
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3.2.5 Power On

See Section 3 in [9].
(Find the code below in Display_COG_Process.c [2])

x{roid Power On (void) Start
discharge low ();
rst low (7;
cs_low (); PWM start
spi_attach (); to toggle
pwm _high () PWM toggle >5ms
Delay ( b5ms);
pwm_lowﬁ ()8 Vce/Vpp voltage

2 2.7V

panelon on ();

T
PWM toggle = 10 ms
v

pwm_high ();

Delay ( 10ms); /CS =1
pwm_low ();
cs_high (); l
border high(); BORDER = 1
rst _high (); l
pwm_high ();
Delay (_5ms); /RESET = 1
pwm low (); :

PWM toggle = 5 ms
rst low (); h 4

RESET = 0

pwm_high (); /
Delay ( b5ms);
pwm_low_ () PWM toggje 2 5ms
rst _high (); /RESET = 1

pwm_high ();
Delay (_5ms);

pwm_low ()
} Initialize Driver

I
PWM toggle = 5 ms
h 4
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3.2.6

SPI command

See Section 1.6 in [9].
(Find the code below in Display_Hardware_Driver.c [2])

void SPI_Send (unsigned char Register, unsigned
char *Data, unsigned Length)
{
cs low ();
SPI Write (0x70);
SPI Write (Register);
while ((UCAOSTAT & UCBUSY))
{
}
cs_high ();
Wait 10us ()
cs low ();

// setup dma

~_datal6 write addr ((unsigned short) &DMA1SA,
(unsigned long) Data);

DMA1SZ = Length;

BITSET (DMA1CTL, (DMAEN)) ;

SPI Write (0x72);

while ((DMA1CTL & DMAIFG) == 0)
{

}

BITCLR (DMA1CTL, DMAIFG);
DMALSZ = 0;

while ((UCAOSTAT & UCBUSY))

{

}

cs_high ();
Wait 10us ()

SPI(OXIllz,OXDlDz)

/CS =1

Delay 10us

/CS =0

y

Header
0x70

¢

Register Index
(OxL1I2)

¢

/CS =1

[
Delay = 10us

/CS =0

!

Header
0x72

v

Send data

F (0xD;D5)

No

Data send
Complete?

Yes

/CS =1
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3.2.7

Initialize Driver

See Section 4 in [9].
(Find the code below in Display_COG_Process.c [2])

void Initialize Driver (uint8 t EPDIndex)

{

uint8 t SendBuffer([2];
uintle t k;

EPD Type Index=EPDIndex;
//Data Line Clear

for (k = 0; k
{

COG Line.uint8[k] =

}

<= LineDataSize; k ++)

0x00;

Driver TypeSelect (EPDIndex) ;

k=0;
//Temperature

SetTemperature Factor (EPDIndex) ;

while
{

if ((k++)>=0xFFF)

}

// SPI
SPI Send

(0x01,

// SPI (0x06,
SPI Send Byte

// SPI (0x07,
SPI Send Byte

// SPI (0x08,
SPI Send Byte

// SPI (0x09,
SendBuffer[0]
SendBuffer[1]
SPI_ Send

// SPI (0x04,
SPI Send Byte

// SPI (0x03,
SPI_Send Byte

// SPI (0x03,
SPI Send Byte

pwm_high ();
Delay (_5ms);
pwm_low ),

// SPI (0x05,
SPI Send Byte

pwm _high ()
Delay (_ 30ms);
pwm_low ),

// SPI (0x05,
SPI Send Byte

(0x01,

(0x09,

(DRIVERBSY IS HIGH)

return;

0x0000, 0x0000, OxOl1lff,

O0xff)
(0x06, Oxff);
0x9d)
(0x07, 0x9d);
0x00)
(0x08, 0x00);
0xd000)

= 0xdO0;

= 0x00;
SendBuffer, 2);

0x03)

(0x04,COG_Parameters[EPDIndex] .

0x01)
(0x03, 0x01);
0x00)

(0x03, 0x00);

0x01)

(0x05, 0x01);

0x03)

(0x05, 0x03);

0xe000)
(uint8 t *)&COG Parameters [EPDIndex] .

ChannelSelect, 8);

VoltagelLevel) ;
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Delay (_ 30ms);

// SPI (0x05, 0xO0f)
SPI Send Byte (0x05, 0x0f);

Delay (_ 30ms);

// SPI (0x02, 0x24)
SPI Send Byte (0x02, 0x24);

Power On

[ ¥

Yes
Busy = 1
No
h 4 v v
Driver latch on
Channel Select (cancel register Outplé?szrl;?gle to
SPI(0x01, Data) noise)
SPI(0x03,0x01) SPI(0x02,0x24)
) 4 A
DC/DC Fr_equency Driver latch off Input Displa
Setting SPI(0x03,0%00) i
SPI(0x06, OxFF) ' Pattern
& v
High Power Mode Star;(():gi?irvgee\p/ump Delav 2 30
i PWM toggle > elay = JUms
Sovisron oug) | "™ | vk 8 VB on
! SPI(0x05,0x01)
PWM togglle > 30 ms
v 4
. PWM stop
Disable ADC
to toggle and
SPI(0x08,0x00) set = 0
v Y
Start chargepump
Set Vcom level neg voltage
SPI(0x09,0xD000) VGL & VDL on
SPI(0x0|5,0x03)
Delay = 30 ms
" Set chav epum
Gate and Source =cL chargepump
Voltage Level V‘iﬁ:rnggﬁﬁlgoogN
SPI(0x04,Data) W
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3.2.8 Temperature Factor

See Section 5.3 in [9].
(Find the code below in Display_COG_Process.c [2])

void SetTemperature Factor (uint8 t EPD Type Index)
{ int8 t Temperature;
Temperature=GetTemperature () ;
if (Temperature < -10)
{ StageTime =GetTime (COG Parameters[EPD Type Index].StageTime) * 17;
else if (Temperature < -5)
StageTime =GetTime (COG Parameters[EPD Type Index].StageTime) * 12;
else if (Temperature < 5)
StageTime =GetTime (COG_Parameters[EPD Type Index].StageTime) * 8;
else if (Temperature < 10)
StageTime = GetTime (COG_Parameters[EPD Type Index].StageTime) * 4;
else if (Temperature < 15)
StageTime =GetTime (COG Parameters[EPD Type Index].StageTime) * 3;
else if (Temperature < 20)
StageTime =GetTime (COG Parameters[EPD Type Index].StageTime) * 2;

else if (Temperature < 40)

StageTime = GetTime (COG_Parameters[EPD Type Index].StageTime) * 1;

StageTime =GetTime (COG_Parameters[EPD Type Index].StageTime) * 7)/10;

TF7
Temperature (°C) V110/v220

<-10 17
52T>-10 12
52T>-5 8
10=T>5 4
15=T>10 3
20=2T=>15 2
40=T>20 1

> 40 0.7
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3.2.9 Display

See Section 5 in [9].

(Find the code below in Display_COG_Process.c [2])

void Display (unsigned char *Picture,unsigned char *PreviousImage)

{
//COG Process

Display Stage 1 (PreviousImage);
Display Stage 2 (PreviousImage);
Display Stage 3 (Picture);
Display Stage 4 (Picture);

For more details on the source code of the four stages above, please find them in
Display_COG_Process.c. The source code below is for the stage 1 (compensate) only.

< Stage 1

(Find the code below in Display_COG_Process.c [2])

void Display Stage_ 1 (uint8 t *PreviousPicture)

{

uintl6 t i, &

uint8 t TempByte; // Temporary storage for image data check
uintlé6 t StartClock;

uint8 t *DataLineOddPrt;

Currentframe=COG Parameters [EPD Type Index].FrameTime;

#if ( MeasureStageMark==1)
LED Red Trigger();

#endif
DisplayOrgPtr=PreviousPicture;
cnt=0;

StartClock = TAIR;
do

{
#if (_ MeasureStageMark==1)
LED Green Trigger();
#endif B B
PreviousPicture=DisplayOrgPtr;

for (i = 0; i < COG_Parameters[EPD Type Index].VERTICAL; i++)// for every line

{
// SPI (0x04, 0x03)

SPI Send Byte (0x04, COG Parameters[EPD Type Index].VoltageLevel);

DataLineOddPrt=(uint8 t

*) &DataLineOdd[COG Parameters [EPD Type Index].HORIZONTAL-1];

for (j = 0; j < COG _Parameters [EPD Type Index].HORIZONTAL; Jj++)
{
TempByte = (*PreviousPicture++) ;
DatalLineEven|[]] = ((TempByte & 0x80) ? BLACK3 : WHITE3)
| ((TempByte & 0x20) ? BLACK2 : WHITE2)
| ((TempByte & 0x08) ? BLACKl : WHITEL)
| ((TempByte & 0x02) ? BLACKO : WHITEO);
* (DatalineOddPrt--) = ((TempByte & 0x01) ? BLACK3 : WHITE3)
| ((TempByte & 0x04) ? BLACK2 : WHITE2)
| ((TempByte & 0x10) ? BLACK1l : WHITE1)
| ((TempByte & 0x40) ? BLACKO : WHITEO);
}
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DataLineScan] (i>>2) ]= ScanTable[ (1%4)1];

// SPI (0x0a, line data....)

SPI Send (0x0a, (uint8 t *)&COG Line.uint8,
COG_Parameters[EPD Type Index].DatalLineSize);

// SPI (0x02, 0x25)
SPI Send Byte (0x02, O0x2F);

DataLineScan|[ (i>>2) 1=0;
}

if (COG_Parameters [EPD Type Index].FrameTime>0)

{
while (Currentframe> (TA1R - StartClock));

}

Currentframe=(TALlR - StartClock)+COG_Parameters[EPD_Type_Index}.FrameTime 8

cnt++;
}while (StageTime>Currentframe);
#if (_ MeasureStageMark==1)
LED Red Trigger();
#tendif

while (StageTime> (TA1R - StartClock));

#if ( MeasureStageMark==1)
LED Red Trigger();

#endif
}
For example:
Previous image 11 10 bitl bit0 Input
New images 11 10 11 Black(B)
Stage 1 10 11 1 0 White(W)
Stage 2 00 10 00 Nothing(N)
Stage 3 00 11
Stage 4 11 10
This table is created by the input data from the [9]. User needs to input the
four stages’ data likes the bits above. One Dot/pixel is comprised of 2 bits.
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Here is an example for stage 1 to get Even and Odd data.

Bit7 | Bit6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | BitO
1 0 1 1 0 1 0 0

TempByte

#define BLACKO = 0x03, BLACKl = 0x0C, BLACK2= 0x30, BLACK3= 0xCO,
WHITEO = 0x02, WHITEl = 0x08, WHITE2 = 0x20, WHITE3 = 0x80
NOTHING = 0x00

(Display COG_Process.h)

Code Result

(TempByte & 0x80) ? BLACK3 : WHITE3 BLACK3 = 0xCO = 1100 0000
(TempByte & 0x20) ? BLACK2Z : WHITE2 BLACK2 = 0x30 = 0011 0000
(TempByte & 0x08) ? BLACKLl : WHITEl WHITE1 = 0x08 = 0000 1000
(TempByte & 0x02) ? BLACKO : WHITEO WHITEO = 0x02 = 0000 0010

DataLineEven = 1100 0000

0011 0000 | 0000 1000 | 0000 0010 = 1111 1010

(TempByte & 0x01) ? BLACK3 : WHITE3 WHITE3 = 0x80 = 1000 0000
(TempByte & 0x04) ? BLACK2 : WHITE2 BLACK2 = 0x30 = 0011 0000
(TempByte & 0x10) ? BLACKLl : WHITEl BLACKl = 0x0C = 0000 1100
(TempByte & 0x40) ? BLACKO : WHITEO WHITEO = 0x02 = 0000 0010

DataLineOdd = 1000 0000 | 0011 0000 | 0000 1100 | 0000 0010 = 1011 1110

Bit7 | Bit6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | BitO
TempByte
1 0 1 1 0 1 0 0
Color
(white(W)=1, w B w w B w B B
black(B)=0)
Stage 1 B w B B W B W W
Compensate
Input 11 10 11 11 10 11 10 10
Even data 11 11 10 10
Odd data 10 11 11 10
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Example for stage 2: White

Bit7 | Bité6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | BitO
TempByte
1 0 1 1 0 1 0 0
Code Result
(TempByte & 0x80) ? WHITE3 : NOTHING WHITE3 = 0x80 = 1000 0000
(TempByte & 0x20) ? WHITE2 : NOTHING WHITE2 = 0x20 = 0010 0000
(TempByte & 0x08) ? WHITEl : NOTHING NOTHING = 0x00 = 0000 0000
(TempByte & 0x02) ? WHITEO : NOTHING NOTHING = 0x00 = 0000 0000
DataLineEven = 1000 0000 | 0010 0000 | 0000 0000 | 0000 0000 = 1010 0000
(TempByte & 0x01) ? WHITE3 : NOTHING NOTHING = 0x00 = 0000 0000
(TempByte & 0x04) ? WHITE2 : NOTHING WHITE2 = 0x20 = 0010 0000
(TempByte & 0x10) ? WHITEl : NOTHING WHITE1 = 0x08 = 0000 1000
(TempByte & 0x40) ? WHITEO : NOTHING NOTHING = 0x00 = 0000 0000
DataLineOdd = 0000 0000 | 0010 0000 | 0000 1000 | 0000 0000 = 0010 1000
Bit7 | Bit6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | Bit O
TempByte
1 0 1 1 0 1 0 0
Color
(white(W)=1, w B W w B w B B
black(B)=0)
1
Stage B | w B B | w | B | W | w
Compensate
Stage 2
: w W w w w w w
White
Input 10 00 10 10 00 10 00 00
Even data 10 10 00 00
Odd data 00 10 10 00
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< Frame Time in Stage

For matching the stage time by MCU frame time (e.g. stage time=480ms for 1.44"”
and 2” when MCU'’s frame time is less than 50ms), using a do-while and count of

the total frame time for each stage has the same stage time. At the end of each

Display_Stage_#, the sample code is as below. The stage time and frame time

can be adjusted at COG Parameters structure in Display COG Process.c

void Display Stage_1 (uint8 t *PreviousPicture)

{

do
{

if (COG_Parameters [EPD Type Index].FrameTime>0)

{
while (Currentframe> (TA1R - StartClock));

}
Currentframe=(TAIR - StartClock)+COG Parameters[EPD Type Index].FrameTime;

CREAFr 2
}while (StageTime>Currentframe) ;
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3.2.10 Power Off

See Section 6 in [9].
(Find the code below in Display_COG_Process.c [2])

void Power_Off (void)
{

‘./I/npui Displa;;‘\‘
\_ Data /

Display Nothing (); v v
Write a Turn off osc
Dummy_line 0 ; Nothing Frame SPI(0x07,0x0D)
Delay ( 25ms); v v
border low () ; Wriiea_ Discharge internal
Delay —( 200ms) ; Dummy Line SPI(0x04,0x50)
border_high () ; Delayi 25ms Delayzl 40 ms
h 4 h 4
// SPI (0x03, 0x01) Discharge i
’ _ ge internal
SPI_Send Byte (0x03, 0x01); BORDER =0 SPI(0x04,0xA0)
// SPI (0x02, 0x05)
SPI Send Byte (0x02, 0x05); Delay 20!3~300m5 Delay = 40 ms
// SPI (0x05, O0xOE)
SPI Send Byte (0x05, O0xOE); Discharge internal
= = BORDER =1
// SPI (0x05, 0x02) SPI(0x04,0x00)
SPI_ Send Byte (0x05, 0x02);
// SPI (0x04, 0x0C) il v
SPI Send Byte (0x04, 0x0C); Set Powers and
Delay ( 120ms); Latch reset turn on Signals = 0 (vee, Veo,
// SPI _(OXO5, OXOO) SPI(0x03,0x01) JRESETJCS.SI.S‘)CLK.
/Border Control
SPI Send Byte (0x05, 0x00);
// SPI (0x07, 0xO0OD) L 2
SPI_Send_Byte (0x07, 0x0D); Output enable off External Discharge =
// SPI (0x04, 0x50) SPI(0x02,0x05) 1
SPI Send Byte (0x04, 0x50);
Delay (_ 40ms); Delay = 150 ms
// SPI (0x04, O0xA0) y
Power off .
SPI Send Byte (0x04, O0xAO0); s e e External Discharge =
Delay (_40ms); SPI(0x05,0%0E) g
// SPI (0x04, 0x00) l
SPI Send Byte (0x04, 0x00); l
Power off chargepump ———
rst low (); neg voltage ( Finish )
spi_detach 0 ; SPI(0x05,0x02) N S

cs_low ()i
panelon on ();
border low();

discharge high ();
Delay (_ 150ms);
discharge low ();

4

Discharge
SPI(0x04,0x0C)

I
Delay = 120 ms

Turn off all
chargepumps
SPI(0x05,0x00)

| I
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3.2.11 Save Image to Flash

The 1.44” and 2" EPD will erase the image area 0 and then store the image data to
image area 0 in flash memory. For 2.7", it will erase the image area that “"State” byte

equals to OxAA.
(Find the code below in Display_Controller.c [2])

void Save_Image (uint8 t EPDType,unsigned char *PreviousImage,unsigned char *NewImage )

{
uintle t 1i,3;
switch (EPDType)
{
case ImageType 1 44:
case ImageType 2 00:
In Flash Image(O Erase();
for (i=0;i< COG_Parameters [EPDType] .VERTICAL+1;i++)
{
j=(uintlé6 t) (COG_Parameters[EPDType] .HORIZONTAL*i) ;
In Flash Image0 Write(j,NewImage+j,COG Parameters[EPDType] .HORIZONTAL) ;
}
break;
case ImageType 2 70:
if (PreviousImage==(uint8 t *)Image(0 FlashAddress)

{
In Flash Image(O Erase();

}

else if (PreviousImage==(uint8 t *)Imagel FlashAddress)

{

In Flash Imagel Erase();

}

break;
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3.3 Project Configurations

Every project will have a set of properties, which include settings for the compiler, linker,
debugger, and more. To view the project properties, right click on the project name at
the top of the file list and select “Properties”.

< Predefined Symbols

- Switch the left side menu of pop-up window to “CCS Build \ MSP430 Compiler \
Advanced Options \ Predefined Symbols”

- AdapTag Host
There is™__CC430F5137__ " and “__AdapTag_HOST” pre-defined names.

-

x+ Properties for AdapTag Host

type filter text Predefined Symbols
> Resource -
CCS General
4 CCS Build Configuration: |Debug [Active ]

4 MSP430 Compiler
Processor Options
Optimization

Pre-define NAME (--defi -D
Debug Options re-aenne (-—define, -D)

_ CCA30F5137_

Include Options _AdapTag_HOST

ULP Advisar
4 Advanced Options
Advanced Debug Of
Language Options

m

Parser Preprocessing
Predefined Symbols
Diagnostic Options

Runtime Maodel Opti

Advanced Optimizati
Entry/Exit Hook Optic Undefine MAME (--undefine, -U)

- AdapTag Slave
There is™__CC430F5137__" and “___AdapTag_SLAVE” pre-defined names.

r

v+ Properties for AdapTag Slave

type filter text Predefined Symbols
Resource -
CCS General
CCS Build Configuration: |Debug [Active ]

MSP430 Compiler
Processor Options

Optimization
P Pre-define NAME (--define, -D)

Debug Options

Include Onti _ CCA30F5137_

nelude Options _AdapTag_SLAVE

ULF Advisor

Advanced Optians
Advanced Debug Of
Language Options

m

Parser Preprocessing
Predefined Symbols
Diagnostic Options

Runtime Madel Optis

Advanced Optimizati Undefine MAME (--undefine, -U)
Entry/Exit Hook Optid
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< Include Options
- Switch the left side menu to “"CCS Build \ MSP430 Compiler \ Include Options”

- AdapTag Host
Add below directories to list for #include search path.

.

¥+ Properties for AdapTag Host

type filter text Include Options
» Resource
CCS General
4 CCS Build Configuration: lDebug [ Active ]

4 MSP430 Compiler
Pracessor Options
SZE:ZZSEEZM Specify a preinclude file (--preinclude)
Include Options
ULP Advisor
. Advanced Options
> MSP430 Linker
Builders
C/C++ Build
C/C++ General
Debug
Praject References
Refactoring Histary Add dir to #include search path (--include_path, -T)
Run/Debug Settings "${CCS_EASE_ROOT}/n‘LSpdl?Oﬁndude"
"$ICG_TOOL ROOT/include”
"${workspace_loc/${PrajMame}/Hast Example Code}”
"${workspace_loc/common/ALPS library}"
"${workspace_loc;/common/DataHandle}"
"${warkspace_loc,/common/ePaper}"
"${workspace_loc,/common/General}”
"${workspace_loc/commaon,/Memary}”

7

7

- AdapTag Slave
(the different is the third list “"Slave Example Code”)

.

v» Properties for AdapTag Slave

type filter text Include Options
> Resource
CCS General
a CCS Build Configuration: IDebug [ Active |

a MSP430 Compiler
Processor Options
Optimization

Specify a preinclude file (--preinclude)

Debug Options
Include Options
ULP Advisor
» Mdvanced Options
» MSP430 Linker

Builders
» C/C++ Build
» C/C++ General
Debug
Project References
Refactoring Histary Add dir to #include search path (--include_path, -)
Ru n/Debug Settings "${CCS_EASE_ROOT};’H‘ISFﬂLgﬂﬁnd ude"
"${workspace_loc/commaon/ALPS library}"
"${workspace_loc,/${ProjMame}/Slave Example Code}"
"${workspace_loc;/commaen/DataHandle}"
"${workspace_loc;/common/ePaper}"
"${workspace_loc,/comman/General}"
"${workspace_loc;/commaon/Memary}”
"${CG_TOOL_ROOTYinclude"
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<{ File Search Path
- Switch the left side menu to “"CCS Build \ MSP430 Linker \ File Search Path”

- AdapTag Host
Add below library file or command file to the list.
"${workspace_loc}/library/AdapTagHostLibrary.1lib" and "libc.a"

-

w» Properties for AdapTag Host

type filter text File Search Path
> Resource
CCE General
a4 CCS Build Configuration: |Debug [Active ]

4 MSP430 Compiler
Processor Options
Optimization

Include library file or command file as input (--library, -I)

Debug Options

Include Options . cpace_l oc}/library/AdapTagHastLibrary.lib

ULP Advisar
» Advanced Options
4 MSP430 Linker
Basic Options
File Search Path
» Advanced Options

Builders
s C/C++ Build Add <dir> to library search path (--search_path, -i)
» C/C++ General "${CCS_BASE_ROOT}/msp430/include”

Debug "§{CG_TOOL_ ROOTHb"

"${CG_TOOL_ROOT}include"

Praject References

Refactorina Historv

- AdapTag Slave
Add below library file or command file to the list.
"${workspace_loc}/library/AdapTagSlaveLibrary.lib" and "libc.a"

~

w¢ Properties for AdapTag Slave

type filter text File Search Path
> Resource
CCS General
4 CCS Build Configuration: |Debug [Active ]

- MSP430 Compiler
a MSP430 Linker
Basic Options
) ilde\r::::dhg::]ons pace_lc-c}f'library{hdapTagSIaveLibrary.lib"

Builders
C/C++ Build
C/C++ General
Debug

Project References

Include library file or command file as input (--library, -[)

7

7

Refactoring History
Run/Debug Settings

Add <dir> to library search path (--search_path, -i)
"${CCS_BASE_ROOT}/msp430/include”

"$1CG_TOOL ROOTH/lib"
"$1CG_TOOL ROOTYinclude"
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4. REFERENCES

The following references provide additional information on the AdapTag development
kit, the Texas Instruments ALPS protocol, and the kit specification in general.

[1] The Microsoft® Visual Studio® project and source code of AdapTag Manager is
available for download on customer zone of PDi website

[2] The Code Composer Studio ™project and firmware source code of AdapTag host
and slave is available for download on customer zone of PDi website

[3] AdapTag Development Kit Quick Start Guide. (Printed copy included in the box
with the kit)

[4] AdapTag Development Kit User Manual (Doc No. 8P002-00)

[5] AdapTag Development Kit COG Driver Programming Guide (Doc No. 8P003-00)
(This document)

[6] AdapTag Development Kit System Development Guide (Doc No. 8P004-00)

[7] AdapTag Development Kit Protocol and Communication Guide (Doc No.
8P005-00)

[8] Code Composer Studio ™(CCStudio) Integrated Development Environment (IDE)
URL: http://www.ti.com/tool/ccstudio

[9] E-paper Display COG Driver Interface Timing (Doc No. 4P008-00 rev.02)

[10]Texas Instruments CC430F5137, 16-Bit Ultra-Low-Power MCU.
http://www.ti.com/product/cc430f5137
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Glossary of Acronyms

EPD Electrophoretic Display (e-Paper Display)
EPD Panel EPD

TCon Timing Controller

MCU Microcontroller Unit

SPI Serial Peripheral Interface

COG Chip on Glass

PDI, PDi Pervasive Displays Incorporated

RF Radio Frequency

ALPS Advanced Low Power Star network protocol

CCS, CCStudio Texas Instruments’ Code Composer Studio ™ IDE development tool

RSSI Received Signal Strength Indicator
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